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Abstrak 
Di Industri otomotif, biaya prototyping meningkat berbanding lurus dengan kompleksitas 

dan dependensi kendaraan. Sebagai alternatif untuk prototyping fisik dapat memanfaatkan 
teknologi baru seperti Augmented Reality (AR) dan Virtual Reality (VR) digunakan. Penggunaan 
VR dan AR melibatkan real-time rendering data CAD yang mengkonsumsi banyak memori dan 
mengurangi kinerja aplikasi. Persiapan data memiliki peran penting untuk meningkatkan kinerja 
sementara tetap mempertahankan topologi dan kualitas mesh. Proses optimalisasi data CAD 
yang digunakan yaitu Tessellation atau mengkonversi NURBS ke Polygons, berperan untuk 
menghasilkan output data yang memiliki efisien kinerja dengan topologi serta kualitas mesh yang 
baik. Hadirnya software 3D Data preparation dan optimasi pada kelas Tessellator. Autodesk 
Maya merupakan software pemodelan 3D yang mendukung Non-Uniform Rational Basis Spline 
ataupun CAD memiliki fitur mengkonversi model NURBS ke polygons, pemilihan kebutuhan atau 
requirement pada tessellation berpengaruh terhadap hasil output. Penilaian dilakukan 
menggunakan penilaian Objektif menggunakan 3D mesh visual quality metrics berbasis vertex-
position Hausdorff Distance sehingga didapatkan requirement pada Tessellation yang efektif. 
Hasil dari konversi memiliki topologi yang serupa dengan software khusus data preparation dan 
optimasi, sedangkan hasil penilaian mesh visual quality metrics requirement yang mendekati 
yaitu menggunakan Tessellation Method Count dan General. 

Kata Kunci— Tessellation, Mesh Visual Quality, CAD, Polygon 

Abstract 
In automotive industry, cost of prototyping increases directly with complexity and 

dependencies of vehicle. As an alternative to physical prototyping can utilize new technologies 
such as Augmented Reality (AR) and Virtual Reality (VR) are used. And involves the real-time 
rendering of CAD data which consumes a lot of memory and reduces application performance. 
Data preparation has an important role to improve performance while maintaining topology and 
mesh quality. Process of optimizing CAD data used is Tessellation or converting NURBS to 
Polygons, whose role is to produce output data that has an efficient performance with topology 
and good mesh quality. Autodesk Maya is a 3D modeling software that supports Non-Uniform 
Rational Base Spline or CAD which has the feature of converting NURBS models to polygons, 
the selection of requirements or requirements on tessellation influences the output results. The 
assessment is done using objective assessment with 3D mesh visual quality metrics based on 
Hausdorff Distance vertex-position so that the requirements for effective Tessellation are 
obtained. The results of the conversion have a topology similar to special data preparation and 
optimization software, while the results of the mesh visual quality metrics requirement approach 
are close to using the Count and General Tessellation method. 
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1. PENDAHULUAN 

Di bidang komputer grafik berbagai konten visual dihasilkan dan pada umumnya dapat 
dikategorikan menjadi dua jenis yaitu 3D data dan gambar 2D (termasuk video, karena pada 
dasarnya video adalah urutan gambar 2D) [1]. Banyak sekali Software grafis komputer 3D yang 
berkembang saat ini dan digunakan untuk membuat animasi 3D, model 3D, game dan gambar. 
Terdapat fitur yang bertujuan untuk membantu seniman, arsitek, insinyur dan desainer diberbagai 
disiplin ilmu dalam merealisasikan proyek mereka. Terlebih perkembangan era saat ini yaitu 
penggunaan Virtual Reality (VR) dan Augmented Reality (AR).  

Sebuah penelitiam sebelumnya mengkombinasikan visualisasi 3D yang digunakan untuk 
optimasi, pemecahan masalah, pelatihan dengan berbagai proses industri yang menunjukkan 
bagaimana game engine telah digunakan untuk menciptakan lingkungan 3D yang interaktif dan 
imersif. Langkah tersebut diambil untuk memvisualisasikan dan mengkomunikasikan hasil 
simulasi antara pengguna yang memiliki berbagai pengalaman dan keahlian [2]. Penggunaan 
Real-time 3D dan VR secara radikal mengubah industri mobil, dengan laju persaingan di industry 
otomotif yang terus berakselerasi dikarenakan peluncuran kendaraan baru per tahun yang tinggi. 
Pembuat mobil tidak boleh hanya mengoptimalkan, tetapi benar-benar mengubah cara mereka 
merancang, merekayasa, membangun, memasarkan, dan memberikan mobilitas. Sebuah Platform 
pengembangan memberikan visualisasi 3D real-time dan VR berpotensi menurunkan biaya dan 
mempercepat waktu pengembangan dan memberikan produk akhir yang berkualitas dan lebih 
terealisasi. Tiga cara real-time 3D dan VR membantu mengubah alur kerja yaitu 
memvisualisasikan cakupan penuh desain pada layar dua dimensi. Penggunaan sistem desain 
konvensional juga tidak memiliki tingkat interaktivitas yang diperlukan untuk menyampaikan 
fitur mobil yang sebenenarnya [3]. 

Tata Elxsi memberikan alternatif prototipe fisik, menggunakan teknologi baru seperti AR 
dan VR. Melihat data desain dalam AR / VR memberikan gambaran nyata tentang produk akhir. 
Penggunaan VR dan AR melibatkan rendering data CAD secara real-time, yang menghabiskan 
banyak memori dan mengurangi kinerja aplikasi. Tata Elxsi melihat kemungkinan untuk 
membuat perubahan secara instan dan membantu dalam pengambilan keputusan yang cepat. 
Persiapan data memainkan peran penting untuk meningkatkan kinerja dengan tetap 
mempertahankan topology dan kualitas mesh. Tata Elxsi menggunakan aplikasi perangkat lunak 
seperti PiXYZ Studio dan Unreal Datasmith untuk mengurangi waktu dan upaya. Laporan ini 
menjadi tolok ukur PiXYZ Studio dibandingkan dengan Datasmith untuk optimisasi.   Sebagai 
software   preparation dan optimisasi keduanya efektif dalam mengimport data CAD. Kinerja 
PiXYZ memungkinkan alur kerja yang lebih cepat dan menghasilkan model yang lebih efisien. 
PiXYZ mampu menyelesaikan beberapa langkah alur kerja 66% lebih cepat dari Datasmith dan 
menghasilkan model yang 28% dari ukuran model Datasmith [4]. 

Proses optimalisasi data CAD yang digunakan yaitu Tesselletion atau mengkonversi 
NURBS ke Polygons. Proses ini memiliki peran penting untuk menghasilkan output data yang 
lebih efisien untuk topologi serta kualitas mesh yang baik. Tata Elxsi menggunakan software 
PiXYZ Studio yang merupakan 3D Data preparation dan optimasi tool pada kelas Tessellator. 
Namun ada salah satu software pemodelan 3D yang mendukung pemodelan Non-Uniform 
Rational Basis Spline ataupun CAD yaitu Atuodesk Maya. Aplikasi ini memiliki fitur untuk 
mengkonversi model NURBS ke polygons atau Tessellation. Pemilihan kebutuhan atau 
requirement pada tessellation berpengaruh terhadap hasil output data yang nantinya hasil output 
tersebut dinilai secara Objektif sehingga didapatkan requirement pada Tessellation yang efektif. 
Hasil dari Tessellation dinilai secara objektif menggunakan 3D mesh visual quality (MVQ) 
metrics berbasis vertex-position yaitu Hausdorff distance. 

Dari latar belakang masalah diatas dapat ditarik rumusan masalah yaitu bagaimana hasil 
surface atau topology yang dihasilkan 3D model NURBS setelah di konversi ke dalam polygonal/ 
tessellation. Selain itu berapa nilai requirement ataupun paramater untuk tessellation yang 
digunakan untuk konversi tersebut sehingga menghasilkan kualitas visual 3D model yang serupa 
dengan software preparation dan optimasi yang dapat dijadikan formulasi. Dan juga bagaimana 
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hasil dari penelitian mengenai konversi/Tessellation terhadap penilaian kualitas visual dari 3D 
meshes. Dari penelitian ini juga dapat dijadikan salah satu acuan penggunaan penilaian kualitas 
data 3D. Selain penilaian secara subjektif, tessellation method yang baik dapat digunakan untuk 
preparation dan optimasi data 3D. 

1.1.  Tessellation Option Pada Maya  

Dalam konversi NURBS ke Polygonal ada pilihan option pada Autodesk Maya yang akan 
dijelaskan sebagai berikut [5]: 
1. Merge Tolerance 

Digunakan untuk mengontrol seberapa dekat simpul harus digabungkan ke dalam Mesh 
tunggal. 

2. Match Render Tesselllation 
Ketika Match Render Tessellation diaktifkan, menggunakan nilai render tessellation yang 
sudah ada yang diatur untuk permukaan NURBS saat mengonversinya ke mesh poligon. 
Akibatnya, mesh polygon yang dikonversi akan cocok dengan versi yang ditampilkan dari 
permukaan NURBS. Ketika History dihidupkan, NURBS ke konversi Polygon akan 
diperbarui setiap kali NURBS membuat nilai tessellation diubah. 

3. Outputting untuk jenis Mesh triangles atau quads 
Terdapat type poligon yang akan digunakan saat mengkonversi Geometri NURBS menjadi 
data poligonal. 

4. Memilih tessellation method 
Tessellation merupakan pembuatan satu set poligon dari geometri NURBS. Setiap metode 
tessellation memberi pilihan yang digunakan untuk mengontrol permukaan poligonal yang 
dihasilkan nantinya.  

Ada empat metode tessellation: “Standard fit”, “General”, “Count”, dan “Control 
Points”. Standard Fit adalah metode tessellation default yang terdapat pada Autodesk Maya yang 
"adaptif" yang berarti bahwa opsi/pilihan ini digunakan untuk menentukan kapan menghentikan 
tessellation. Sealain hal tersebut terdapat pilihan pada setiap metode pada tessellation. 

Berikut merupakan opsi dari tessellation yang terdapat pada Autodesk Maya: 
1. Chord Height Ratio 

Rasio Tinggi Chord adalah rasio antara jarak maksimum kurva dari tepi poligon yang 
digunakan untuk memperkirakannya dan panjang chord. Panjang akord adalah jarak linear 
antara dua simpul poligon. 

2. Fractional Tolerance 
Nilai Toleransi Fraksi menentukan tingkat akurasi yang dipertahankan antara permukaan asli 
dan permukaan poligonal interpolasi. Standarnya adalah akurat dalam 0,01 unit, di mana unit 
mengacu pada satuan pengukuran linier saat ini (satuan ukuran standar adalah sentimeter). 
Oleh karena itu, tidak ada titik permukaan poligonal lebih dari toleransi jarak jauh dari 
permukaan NURBS asli. 

3. Delta 3D 
Nilai Delta 3D menentukan jarak 3D untuk isoparm U dan V pada permukaan yang 
membentuk grid awal untuk tessellation. Dalam contoh berikut, nilai Delta 3D diubah dari 
standar 0,1 ke 1,0. 

4. General 
Setiap rentang / permukaan dibagi menjadi sejumlah poligon tergantung pada nilai-nilai 
Number U dan V yang ditetapkan 

Tipe U / Tipe V 

Item menu pop-up Tipe U dan Tipe V memungkinkan untuk menentukan apakah ingin 
membagi permukaan berdasarkan di mana rentangnya (kemudian membelah setiap rentang), 
atau berdasarkan parameterisasi seluruh permukaan. 
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Number U / Number V 

Setiap rentang atau permukaan dibagi menjadi jumlah poligon yang di tentukan 

5. Count 
Slider Count digunakan untuk menentukan berapa banyak poligon yang permukaannya dapat 
di-tessellated. 

6. Control Point 
Metode tessellation ini mengubah model NURBS menjadi poligon sambil mencocokkan CV 
dari permukaan NURBS asli. 

1.2.  Metrik kualitas visual 3D  

Kemajuan komputer grafik meningkatkan ekstensif penggunaan data 3D dalam banyak 
aplikasi dan domain, seperti virtual reality (VR), e-commerce, digital entrainments, visualisasi 
ilmiah, dll. Data 3D yang paling sering digunakan diwakili dalam bentuk mesh poligonal. 
Beragam metrik kualitas visual 3D dirancang untuk mengevaluasi / meningkatkan semua operasi 
pemrosesan pada objek 3D (misalnya simplifikasi, kompresi, watermarking, dll) [6]. 

Vertex-Position Based Metrics Mengacu pada jarak posisi geomtris [7]. Metric yang 
banyak digunakan adalah Hausdorff distance, dirancang untuk mengevaluasi algoritma 
penyerderhanaan. Jarak Hausdorff dihitung menggunakan persamaan 1 samapai dengan 4.  
Persamaan 1 menunjukan e (p, A) mewakili jarak minimum dari titik 3D spatial point p ket sebuah 
titik 3D mesh A. Dimana d adalah jarak Euclidian, dan vA i berarti vertex ke-1 A. 

 
𝑦𝑦(𝑝𝑝,𝐴𝐴) = min𝑃𝑃

𝑉𝑉𝑖𝑖
𝐴𝐴∈ 𝐴𝐴

(𝑝𝑝, 𝑣𝑣𝑖𝑖𝐴𝐴)    (1) 

 
Jarak Hausdorff antara dua jerat A dan B dihitung menggunakan persamaan 2. 
 

𝐻𝐻𝑎𝑎(𝐴𝐴,𝐵𝐵) =  max
𝑣𝑣𝑖𝑖
𝐴𝐴∈𝐴𝐴

(𝑣𝑣𝑖𝑖𝐴𝐴,𝐵𝐵)                (2) 

 
Sehingga, jarak Hausdorff simetris dapat dihitung menggunakan persamaan 3. 
 

𝐻𝐻 (𝐴𝐴,𝐵𝐵) = max {𝐻𝐻𝑏𝑏 (𝐴𝐴,𝐵𝐵),𝐻𝐻𝑏𝑏 (𝐵𝐵,𝐴𝐴)}  (3) 
 
Ensemble dari e (𝑣𝑣𝑖𝑖𝐴𝐴,𝐵𝐵) dapat dianggap sebagai prediksi lokal dari perbedaan antara dua 

mesh A dan B. Dimana n berarti jumlah simpul pada dua mesh masing-masing, 𝑣𝑣𝑖𝑖𝐴𝐴 dari B adalah 
verteks yang sesuai dengan vertex 𝑣𝑣𝑖𝑖𝐴𝐴 pada mesh A yang dapat dilihat pada persamaan 4. Definisi 
ini membatasi perbandingan antara dua mesh memiliki konektivitas yang sama. 

 
𝑅𝑅𝑅𝑅𝑅𝑅(𝐴𝐴,𝐵𝐵) = (∑ ||𝑣𝑣𝑖𝑖𝐴𝐴 − 𝑣𝑣𝑖𝑖𝐵𝐵𝑛𝑛

𝑖𝑖=1 ||2)1/2                  (4) 

2. METODE PENELITIAN 

Gambar 1 merupakan tahapan penelitian yang akan dilakukan. Tahap pertama Model 
Mobil 3D yaitu menyiapakan dua design 3D mobil berekstensi wire atau pembuatan dilakukan 
pada Autodesk alias NURBS dengan jenis mobil Buggy Car dan City Car. Kemudian tahap 
pertama atau INPUT dilakukan import pada masing-masing software yaitu pada Autodesk Maya 
dan pada PiXYZ Studio yang nantinya akan masuk pada tahap selanjutnya yaitu data proses. 
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Gambar 1. Alur Penelitian 

Tahapan selanjutnya adalah Tessellation dan input kebutuhan parameter Maya pada 
model mobil NURBS dengan menentukan inputan requirement Merge tolerance, type polygon, 
ataupun tessellation method. Setiap inputan parameter yang berbeda akan menjadi sampel. 
Misalnya sample satu dengan Tessellation method yang digunakan adalah general dengan initial 
tessellation controls dan secondary tessellation controls. Beberapa sample mengacu pada 
standard requirement pada Maya untuk pembuatan sample yang lain dibuat dengan inputan 
parameter yang bervariasi mengacu pada knowledge Autodesk Maya. Dari proses ini 
menghasilkan sampel yang nantinya akan di export menjadi wavefront 3D sehingga setiap sampel 
hasil konversi akan dinilai pada MeshLab.  

Pada tahap ketiga atau Tessellation pada PiXYZ Studio dengan standar requirement pada 
Tata Elxsi, menggunakan Parameters - Max Sag = 0.1, Max Angle = 7, UV Mode = UniformUV, 
Create Tangents dan Create Binormals checked pada Advanced options.  



   
124       ISSN: 2354-5771 

 

Pada tahap keempat yaitu Output 3D model yang sudah dilakukan tessellation pada 
masing-masing software baik itu Maya ataupun PiXYZ. Kemudian, dieksport menjadi wavefront 
3D (.OBJ) pada 3D model PiXYZ Studio. Data mobil digunakan sebagai referensi, masing-
masing data masuk pada perbandingan mengenai topologi dari model sperti jumlah vertex dan 
juga faces. Pada tahapan kelima yaitu Perbadingan topologi data sampel dengan referensi 
mengenai jumlah vertex dan face. Selanjutnya dilakukan penilaian kualitas visual 3D mesh 
dimana setiap sampel model dinilai dengan vertex position based matric menggunakan distortion 
map Hausdorff Distance. Cara ini dilakukan yaitu dengan penilaian mengenai jarak posisi 
geometris dari mesh yang ada pada 3D model. Data mobil yang dikonversi pada Autodesk Maya 
akan dinilai dengan model referensi pada software PiXYZ Studio dengan penilaian Hausdorff 
menggunakan persamaan metric RMS atau Root Means Square. Hasil akan keluar dengan nilai 
range 0-1, data model 3D bernilai mendekati 0 jika data mobil memiliki range distance mendekati 
dengan data referensi yaitu pada tahapan keenam Mesh Visual Quality. 3D model mobil diimport 
pada Meshlab data pada PiXYZ kemudian dijadikan referensi untuk penilaian. Dari hasil 
perbandingan dan juga penilaian dengan Hausdorff yang menjadi acuan selesainya alur penelitian 
yaitu jika data sample mendekati dengan data referensi baik itu topologi maupun penilaian 
hausdorff distance. Pengulangan dilakuan apabila data sample masih jauh dari data referensi. 

3. HASIL DAN PEMBAHASAN 

Dari alur penelitian terdapat 4 poin penting dalam penelitian yang menjadi tahapan 
sebagai berikut. 

3.1. Input Model Mobil 3D 

Pada tahap awal yaitu mempersiapkan model 3D mobil yaitu dua model mobil NURBS 
pada Autodesk ALIAS Autostudio 2018. Autodesk Alias merupakan software yang menyediakan 
alat untuk desain, pemodelan konsep, visualisasi desain industry, produk dan otomotif. Proses 
pembuatan model secara detail tidak dijelaskan dalam laporan ini karena fokus utama penelitian 
ini adalah pada konversi NURBS ke Polygonal atau Tesselation pada mobil. Gambar 2 adalah 2 
jenis mobil pada Autodesk Alias tampak dari depan dan tampak dari samping kanan. A 
merupakan tampak depan dari Buggy Car, B tampak samping Buggy car, C tampak depan City 
Car dan D tampak samping City Car. 

 
Gambar 2.  Model Mobil NURBS pada Autodesk Alias 

Proses selanjutnya adalah import model 3D NURBS pada Autodesk Maya dengan cara 
pilih File>Import kemudian pilih model mobil NURBS. Dilakukan juga import pada software 
PiXYZ Studio sebagai data referensi dengan cara File>Import Model. 
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3.2. Data Proses 

Tahap data proses terdiri dari tessellation pada PiXYZ Studio sebagai referensi dengan 
requirement sesuai dengan report yang dikeluarkan Tata Elxsi (Parameters- Max Sag = 0.1, Max 
Angle = 7, UV Mode = UniformUV, Create Tangents & Create Binormals are checked in the 
Advanced options.) [3]. Pada Autodesk Maya, Tessellation terdapat pada saat model NURBS 
dikonversi menjadi polygonal. Pada software Maya yang terletak dimenu dengan memilih 
modify>convert> NURBS to Polygon pilih advance. Pada tessellation terdapat requirement yang 
digunakan untuk mengontrol permukaan poligon yang dihasilkan. Terdapat empat metode 
tessellation Standard fit, General, Count, and Control Points. Mengacu pada Autodesk 
knowledge Network Tessellation requirement yang diberikan pada Atuodesk Maya sebagai data 
sampel untuk diberikan nilai default dan beberapa nilai eksperimen berpedoman pada knowledge. 
Berikut nilai requirement yang diinputkan dalam bentuk tabel 1 parameter tessellation pada Maya. 

Tabel 1. Parameter Tesselation pada Maya 

Model 3D Nama 
Sampel 

Tessellation Requirement 
Tessellation 

Method Value Tessellation Method 

Buggy Car BC1 Control Point  
Buggy Car BC2 Count Default 200 
Buggy Car BC3 Count 250 
Buggy Car BC4 Count 300 
Buggy Car BC5 Count 350 
Buggy Car BC6 Count 400 
Buggy Car BC7 Count 420 
Buggy Car BC8 Standard fit Chrod height ratio= 0.1 ;Fractional Tolerance= 0.01 ;Minimal 

Edge Length= 0.001 ;3D Delta=0.1 ; 
Buggy Car BC9 Standard fit Chrod height ratio= 0.2 ;Fractional Tolerance= 0.02 ;Minimal 

Edge Length= 0.002 ;3D Delta=0.2 ; 
Buggy Car BC10 Standard fit Chrod height ratio= 0.3 ;Fractional Tolerance= 0.03 ;Minimal 

Edge Length= 0.003 ;3D Delta=0.3 ; 
Buggy Car BC11 Standard fit Chrod height ratio= 0.4 ;Fractional Tolerance= 0.04 ;Minimal 

Edge Length= 0.004 ;3D Delta=0.4 ; 
Buggy Car BC12 General Per Surf U value =3 ; Per Surf V value =3 ; 
Buggy Car BC13 General Per Surf U value =4 ; Per Surf V value =4 ; 
Buggy Car BC14 General Per Surf U value =5 ; Per Surf V value =5 ; 
Buggy Car BC15 General Per Surf U value =21 ; Per Surf V value =21 ; 
Buggy Car BC16 General Per Surf U value =25 ; Per Surf V value =25 ; 
Buggy Car BC17 General Per Surf U value =22 ; Per Surf V value =22 ; 
City Car CC1 Control Point  
City Car CC2 Count Default 200 
City Car CC3 Count 250 
City Car CC4 Count 300 
City Car CC5 Count 350 
City Car CC6 Count 400 
City Car CC7 Count 420 
City Car CC8 Standard fit Chrod height ratio= 0.1 ;Fractional Tolerance= 0.01 ;Minimal 

Edge Length= 0.001 ;3D Delta=0.1 ; 
City Car CC9 Standard fit Chrod height ratio= 0.2 ;Fractional Tolerance= 0.02 ;Minimal 

Edge Length= 0.002 ;3D Delta=0.2 ; 
City Car CC10 Standard fit Chrod height ratio= 0.3 ;Fractional Tolerance= 0.03 ;Minimal 

Edge Length= 0.003 ;3D Delta=0.3 ; 
City Car CC11 Standard fit Chrod height ratio= 0.4 ;Fractional Tolerance= 0.04 ;Minimal 

Edge Length= 0.004 ;3D Delta=0.4 ; 
City Car CC12 General Per Surf U value =3 ; Per Surf V value =3 ; 
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Model 3D Nama 
Sampel 

Tessellation Requirement 
Tessellation 

Method Value Tessellation Method 

City Car CC13 General Per Surf U value =4 ; Per Surf V value =4 ; 
City Car CC14 General Per Surf U value =5 ; Per Surf V value =5 ; 
City Car CC15 General Per Surf U value =21 ; Per Surf V value =21 ; 
City Car CC16 General Per Surf U value =25 ; Per Surf V value =25 ; 
City Car CC17 General Per Surf U value =22 ; Per Surf V value =22 ; 

 
Pada kolom Model 3D merupakan jenis dari model mobil, sedangkan nama sampel 

merupakan sampel dari masing-masing jenis mobil. Tessellation method dan value merupakan 
jenis dari tessellation yang digunakan dan nilai yang diinputkan pada masing-masing method.  

3.3 Output Hasil Konversi dan Topology 

Bagian output merupakan data mobil 3D yang sudah dikonversi menjadi polygon atau 
Tessellation. Topologi ataupun permukaan pada model 3D menyesuaikan dengan opsi yang ada 
pada Tessellation. Gambar 3 merupakan hasil dari Tesselation ataupun konversi NURBS ke 
Polygonal dari beberapa sampel. A merupakan data mobil yang dihasilkan dari referensi dan B 
samapai D merupakan sampel hasil dari masing-masing sampel, begitu juga untuk E sampai H 
namun dengan jenis mobil City Car. Dengan A sebagai Buggy Car Reference, B. Buggy Car BC1, 
C. Buggy Car BC2, D. Buggy Car BC3, E. City Car Reference, F. City Car CC1, G. City Car 
CC2, H. City Car CC3 

 
Gambar 3. Hasil Tesselation  

Setiap sampel hasil tessellation juga memiliki jumlah poly/poly count yang berbeda-beda. 
Data referensi yang dihasilkan oleh Software PiXYZ Studio dijadikan acuan topologi dan kualitas 
mesh data model. Tabel 2 memperlihatkan Poly Count pada setiap sample. 

Tabel 2. Poly Count 

No Nama Sampel Jumlah 
Vertices Faces 

1 Buggy Car Reference 377951 684603 
2 BC1 49533 71202 
3 BC2 290814 478346 
4 BC3 356127 596969 
5 BC4 422637 719421 
6 BC5 484896 834396 
7 BC6 551956 959259 
8 BC7 573367 998855 
9 BC8 95595 146495 

10 BC9 53660 78761 
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No Nama Sampel Jumlah 
Vertices Faces 

11 BC10 42923 61477 
12 BC11 35167 48565 
13 BC12 103453 163234 
14 BC13 107973 170657 
15 BC14 113497 178961 
16 BC15 558609 1008390 
17 BC16 773651 1420258 
18 BC17 608771 1104097 
19 City Car Reference 205816 371470 
20 CC1 36476 53956 
21 CC2 111641 171888 
22 CC3 135052 212728 
23 CC4 156988 251302 
24 CC5 181533 295314 
25 CC6 204228 336250 
26 CC7 211709 349576 
27 CC8 29186 43050 
28 CC9 17833 25087 
29 CC10 14190 19296 
30 CC11 12750 17040 
31 CC12 50760 79620 
32 CC13 49357 77104 
33 CC14 51114 79788 
34 CC15 197040 351246 
35 CC16 270667 491602 
36 CC17 213784 383181 

 
Untuk mempermudah melihat perbandingan data sample dengan referensi mengenai 

topology yang mendekati dengan data referensi, dapat dilihat pada Gambar 4 yang menampilkan 
grafik hasil dari perbandingan jumlah vertex dan face pada bugy car. Gambar 5 merupakan grafik 
hasil dari perndingan jumlah vertex dan face pada City car: 

Gambar grafik pertama pada Gambar 4 merupakan hasil dari perbandingan jumlah vertex 
dan grafik kedua adalah face pada Buggy Car. Bar sebelah kiri menunjukan data sampel dari 
masing-masin hasil tessellation yang sudah diberikan nama sampel sedangkan bar sebelah kanan 
merupakan data dari referensi, data menunjukan kesesuaian apabila memiliki posisi yang sejajar. 

Gambar 5 merupakan hasil perbandingan dari citycart setelah dilakukan konversi/ 
tessellation, grafik pertama pada Gambar 5 merupakan hasil dari perbandingan jumlah vertex. 
Dan grafik kedua pada Gambar 5 adalah face pada City Car, bar sebelah kiri menunjukan data 
sampel dari masing-masing hasil tessellation yang sudah diberikan nama sampel. Bar sebelah 
kanan merupakan data dari referensi. Data menunjukan kesesuaian apabila memiliki posisi yang 
sejajar. 
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Gambar 4. Grafik perbandingan Jumlah vertex daan face pada Buggy Car  

 
Gambar 5. Grafik perbandingan jumlah vertex dan face pada City Car  
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Dari data perbandingan mengenai topology pada jumlah vertex dan face untuk setiap data 
sample dan referensi, pada model mobil Buggy Car sampel yang mendekati dengan referensi 
terdapat pada BC3 dan BC4 dengan requirement Tessellation method yang digunakan adalah 
Count dengan nilai 250-300. Sedangkan pada Citty Car terdapat pada CC6, CC7, CC15 dan CC17 
dengan Tessellation method yang digunakan adalah Count dengan nilai 400-420 untuk CC6 dan 
CC7. Sedangkan pada CC15 dan CC17 menggunakan Tessellation Method General dengan nilai 
Per Surf U value 21-25; Per Surf V value 21-25. 

3.4 Mesh Visual Quality 

Tahapan ini merupakan tahap pengukuran kualitas secara Objektif dengan menggunakan 
Vertex-Position Based Metric yaitu menggunaan Hausdorff Distance. Hausdorff Distance 
digunakan untuk komputasi titik terdekat atau point mesh pada mesh sample/data sampel dengan 
mesh referensi/data referensi dari komputasi. Proses tersebut menghasilkan RMS dari data 
referensi dan data sampel yang dinilai. Data output mobil 3D dari software PiXYZ Studio dan 
Maya yang sudah diproses atau Tessellate kemudian dieksport dalam bentuk warefront / OBJ 
yang selanjutnya diimport pada MeshLab. Untuk penilaian menggunakan Hausdorf Distance pada 
Meshlab dapat dilakukan dengan cara seleksi pada data sampel kemudian pilih 
Filter>Sample>Hausdorff Distance. Requirement pada Hausdorf Distance yang digunakan 
adalah default dari Meshlab. Sampled Mesh adalah data ataupun mesh yang akan dikomputasi 
mengenai point dari Mesh sample dengan Target Mesh atau data referensi sehingga dihasilkan 
nilai RMS, dengan ketentuan semakin kecil nilai yang dihasilkan berarti point mesh sampel 
semakin mendekati dengan data referensi atau terget mesh. Hasil akan muncul pada Box Result. 
Hasil dari data sampel keseluruhan untuk Buggy Car dan City Car dapa dilihat pada Gambar 6 
Grafik Hasil dari hausdorff Distance. 
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Gambar 6. Grafik perbandingan hasil dari Hausdorff Distance 

Hasil dari grafik dapat dilihat nilai terendah yang dihasilkan dari Hausdorf distance yaitu 
pada Buggy Car terdapat pada sampel BC4 dengan nilai RMS 0,002208 dan BC7 dengan nilai 
RMS 0,002209. Sedangkan pada City Car nilai pada CC17 dengan RMS 0,00106 dan juga CC15 
dengan RMS 0,00103. Dari hasil penilaian Hausdorff dan juga perbandingan topology 
menunjukan bahwa requirement dengan Tessellation method mendekati data referensi yang 
digunakan yaitu Count dengan rentan nilai 300-420 dan General dengan nilai Per Surf U value 
21-25; Per Surf V value 21-25. 

4. KESIMPULAN  

Penggunaan Software Autodesk Maya dapat dijadikan salah satu alternatif sebagai 
software data preparation dan optimization. Selain dari fungsi utama yaitu untuk pemodelan 3 
dimensi, dukungan berbagai CAD format yang dapat diimport pada Autodesk maya menambah 
point tersendiri. Software automotive seperti Autodesk Alias 2018 sudah bundle atau satu paket 
dengan Autodesk maya sehingga dapat menekan dari sisi biaya operasional. 

Hasil dari konversi atau tessellation memiliki topology yang serupa dengan software 
khusus data preparation, opeimization dan review dengan software pembanding sebagai referensi 
yaitu PiXYZ Studio. Untuk requirement yang digunakan pada tessellation Maya dengan 
perbandingan topology dengan requirement Tessellation method yang digunakan yaitu Count 
dengan rentan nilai 300-420 dan General dengan nilai Per Surf U value 21-25; Per Surf V value 
21-25. Hasil penilaian dengan Hausdorff distance terhadap data output tessellation sampel 
menunjukan perhitungan RMS yang juga mendekati dengan data referensi. 
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5. SARAN 

Dari hasil tessellation pada Autodesk Maya dengan referensi pada PiXYZ Studio masih 
belum dalam tingkat akurasi yang sama. Terdapat faktor yang mempengaruhi dari tessellation 
yaitu metode yang digunakan masing-masing software. Pengkajian untuk metode tessellation 
perlu dilkukan lebih mendalam dan kedepannya pembuatan tool pada Maya untuk mempermudah 
dalam konversi/tessellation berikutnya, baik itu dengan MELScript ataupun pemrograman yang 
lain dapat dikembangkan. 
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